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lîÉêîáÉï

Attachmate INFOConnect Airlines Gateway is a combination of software 
components and administrative tools that run on a Windows server. You 
can use this product to manage communication between networked PCs 
using Attachmate Airlines Client Emulation products and any host that 
supports Mapping of Airline Traffic over Internet Protocol (MATIP) 
including Amadeus, Worldspan, SabreIP, and Galileo/Apollo. 

INFOConnect Airlines Gateway manages communication for networked 
PCs running the following products:

• INFOConnect Enterprise Edition

• e-Vantage HAS for Airlines

• Reflection for the Web 2008, Airlines Edition

• Verastream SDK for Unisys and Airlines

For more information about INFOConnect, see the INFOConnect 
Enterprise Edition Product Guide.

kìãÄÉê=çÑ=`çååÉÅíáçåë=pìééçêíÉÇ
The INFOConnect Airlines Gateway supports up to 100 terminal addresses 
per host protocol (MATIP, SabreIP, or ATSTCP).

kÉï=cÉ~íìêÉë
This release includes the following features:

• Compatible with Windows 7 and Vista certified.

• Attachmate implementation of Windows Vista certified installers using 
the MS Windows Installer XML (WIX) open source toolkit and MSI-
based deployment technologies and customizations.

• Support for the increased IP addressing and capabilities of IPv6.

• Sabre NOFEP support — requires a C Common Sabre Application 
Programming Interface (CCSAPI) license from Sabre.

• New display font (Segoe UI Mono) for better scalability on newer 
screens. To use this font in a session, choose Options > Settings. On the 
left, select Display. The Fonts tab provides a menu from which you can 
choose the font. 

• Ability to specify the amount of hard disk space devoted to trace files. 
For details, see “Tracing INFOConnect Paths” on page 15.
N



fkcl`çååÉÅí=^áêäáåÉë=d~íÉï~ó=mêçÇìÅí=dìáÇÉ
j~àçê=`çãéçåÉåíë
INFOConnect Airlines Gateway includes the following components:

kçíÉW=^åó=åÉíïçêâÉÇ=m`=ÅçååÉÅíáåÖ=íç=íÜÉ=fkcl`çååÉÅí=^áêäáåÉë=
d~íÉï~ó=ãìëí=ìëÉ=íÜÉ=fkcl`çååÉÅí=^fod^qb=íê~åëéçêí=çê=~åçíÜÉê=
d~íÉï~óJÅçãé~íáÄäÉ=íê~åëéçêíK

`çãéçåÉåí aÉëÅêáéíáçå

Gateway 
Service

The Windows service that provides client-to-host 
connectivity.

Gateway 
Administrator

An application that you can use to configure the 
connection settings for all the networked PCs that will 
be accessing the host.

Gateway 
Transports

Software that processes communication for a particular 
kind of network and host. Five transports are available: 
SABREGW (OFEP support), SABRE2 (NOFEP 
support) MATIPGW, UDPFRAD and ATSTCPGW. 

Gateway 
Monitor

A utility that you can use to monitor communication 
between the client and the Gateway.

INFOConnect 
Manager

The user interface for INFOConnect Connectivity 
Services, a package of communication software that 
runs in the background and stores the connection data 
specified using Gateway Administrator. INFOConnect 
Manager can be used to monitor communication 
between the Gateway and the host.

Export-Import 
Utility

A tool that allows you to export data from any 
INFOConnect database into an .ini or .csv file, as well as 
import data from an .ini or .csv file into an 
INFOConnect database. This utility may be used for 
creating backups, for troubleshooting, or for merging 
multiple INFOConnect databases into a single master 
database.

CnfEdit A utility that allows you to edit certain configuration 
files used with the Airlines Gateway host transports.
O



póëíÉã=oÉèìáêÉãÉåíë
For production environments, many users install the various INFOConnect 
components on separate computers. Specific requirements will vary based 
on which components are installed, and on other hardware and software 
components present. 

kçíÉW=^íí~ÅÜã~íÉ=Å~ååçí=ÅçåÑáêã=íÜÉ=~ÅÅìê~Åó=çÑ=éÉêÑçêã~åÅÉI=çê=~åó=
çíÜÉê=Åä~áãë=êÉä~íÉÇ=íç=åçåJ^íí~ÅÜã~íÉ=éêçÇìÅíëK=cçê=èìÉëíáçåë=çê=
ÅçåÅÉêåë=êÉÖ~êÇáåÖ=íÜÉ=Å~é~ÄáäáíáÉë=çÑ=åçåJ^íí~ÅÜã~íÉ=éêçÇìÅíëI=éäÉ~ëÉ=
Åçåí~Åí=íÜÉ=ëìééäáÉêë=çÑ=íÜçëÉ=éêçÇìÅíëK

INFOConnect Airlines Gateway can take advantage of the additional 
address space and capabilities available through IPv6, and it meets the 
requirements for Works with Windows Vista certification. Follow the 
Microsoft guidelines for Windows Vista system requirements

The minimum system requirements are covered in the following table.

kçíÉW=fkcl`çååÉÅí=^áêäáåÉë=d~íÉï~ó=Å~ååçí=ÄÉ=áåëí~ääÉÇ=çå=táåÇçïë=
kq=ëÉêîÉêëK

póëíÉã=`çãéçåÉåí aÉëÅêáéíáçå

Operating System Windows 7
Windows Vista SP1 or greater
Windows XP Professional with SP1 or SP2
Windows 2000 Professional with SP4
Windows 2000 Server and Windows Server 
2003 with SP1

Processor 500 MHz Intel Pentium-class

RAM 128 MB

Networked PC 
Components

A networked PC connecting to the 
INFOConnect Airlines Gateway must use the 
INFOConnect AIRGATE transport or 
another Gateway-compatible transport.

Additional Requirements Both server and client PC must be connected 
to a TCP network.
P



fkcl`çååÉÅí=^áêäáåÉë=d~íÉï~ó=mêçÇìÅí=dìáÇÉ
^Äçìí=qÜáë=mêçÇìÅí=dìáÇÉ=~åÇ=låäáåÉ=eÉäé
Information about INFOConnect Airlines Gateway is available through this 
product guide and the component Help systems.

INFOConnect 
Airlines Gateway 
Product Guide

This guide provides an overall description of this 
product and the solutions you can create with it.

Component Help 
Systems

General help and context sensitive help is 
available. The Help systems uses WinHlp32.exe, 
which is not included with Windows Vista. To 
open INFOConnect help on Vista, you may need 
to install the Windows Help program. For more 
information see Attachmate Technical Note 2294 
http://support.attachmate.com/techdocs/
2294.html. Technical Note 2294 also contains 
information on resolving the following error 
message that may appear when accessing Help on 
Vista Windows: There was a problem running the 
macro.(1037).
Q



fåëí~ääáåÖ=~åÇ=dÉííáåÖ=pí~êíÉÇ

vçì=Å~å=áåëí~ää=fkcl`çååÉÅí=̂ áêäáåÉë=d~íÉï~ó=çå=~åó=táåÇçïë=ëÉêîÉê=áå=
óçìê=åÉíïçêâ=íÜ~í=ãÉÉíë=íÜÉ=ÅêáíÉêá~=ëéÉÅáÑáÉÇ=áå=íÜÉ=ëóëíÉã=
êÉèìáêÉãÉåíëI=çê=çå=íÜÉ=ë~ãÉ=ÅçãéìíÉê=~ë=fkcl`çååÉÅí=båíÉêéêáëÉ=
bÇáíáçå=îÉêëáçå=VKMK

kçíÉW=tÜÉå=óçì=áåëí~ää=fkcl`çååÉÅí=^áêäáåÉë=d~íÉï~óI=óçì=ãìëí=
éÉêÑçêã=íÜÉ=áåëí~ää~íáçå=ÇáêÉÅíäó=~í=íÜÉ=ëÉêîÉê=áíëÉäÑ=ê~íÜÉê=íÜ~å=Ñêçã=~=
m`=ÅçååÉÅíÉÇ=íç=íÜÉ=ëÉêîÉêK=qÜáë=ÉåëìêÉë=íÜ~í=íÜÉ=ëÉêîÉê=Ü~ë=~ää=íÜÉ=
åÉÅÉëë~êó=táåÇçïë=êÉÖáëíêó=ÉåíêáÉëK

pí~êíáåÖ=ïáíÜ=îÉêëáçå=PKMI=íÜÉ=fkcl`çååÉÅí=^áêäáåÉë=d~íÉï~ó=áåëí~ää~íáçå=
ìëÉë=íÜÉ=ëí~åÇ~êÇ=^íí~ÅÜã~íÉ=fåëí~ääÉê=mêçÖê~ãK=

fåëí~ääáåÖ=fkcl`çååÉÅí=^áêäáåÉë=d~íÉï~ó
vçì=ãìëí=éÉêÑçêã=íÜÉ=áåëí~ää~íáçå=ÇáêÉÅíäó=~í=íÜÉ=ëÉêîÉê=ê~íÜÉê=íÜ~å=Ñêçã=
~=m`=ÅçååÉÅíÉÇ=íç=íÜÉ=ëÉêîÉêK=vçì=Å~å=êìå=íÜÉ=pÉíìé=ïáò~êÇ=Ñêçã=~=
Ççïåäç~Ç=ëáíÉ=çê=Ñêçã=~å=~Çãáåáëíê~íáîÉ=áåëí~ää=áã~ÖÉK

qç=áåëí~ää=fkcl`çååÉÅí=^áêäáåÉë=d~íÉï~ó

kçíÉW=vçì=ãìëí=äçÖ=çå=ïáíÜ=~Çãáåáëíê~íçê=éêáîáäÉÖÉë=íç=áåëí~ää=íÜÉ=
éêçÇìÅíK=fÑ=óçì=Çç=åçí=Ü~îÉ=íÜÉ=åÉÅÉëë~êó=~ÅÅÉëë=êáÖÜíëI=~ëâ=óçìê=
ëóëíÉã=~Çãáåáëíê~íçê=íç=ÉäÉî~íÉ=óçìê=éêáîáäÉÖÉëK

1. Run the Setup wizard.

2. From the Setup wizard, click Continue, and then follow the instructions 
on the Setup wizard user interface.

3. (Optional) To personalize the installation, click the User Information tab 
and enter the name, organization, and Volume Purchase Agreement 
(VPA) number (if you have a VPA). The purpose of VPA numbers, 
which are issued by Attachmate, is to allow customer support to expedite 
service requests. 

4. (Optional) Click the File Location tab and browse to the folder in which 
you want to install INFOConnect to change the default installation 
folder.

fÑ=óçì aç=íÜáë

Install from a download 
site

Click the download link and run the 
download program. Select a location for 
the installer files and click Next. This 
extracts the files to the specified location 
and starts the Setup wizard.

Install from an 
administrative install 
image

From the administrative installation 
point, double-click the setup.exe file.
R



fkcl`çååÉÅí=^áêäáåÉë=d~íÉï~ó=mêçÇìÅí=dìáÇÉ
fåëí~ääÉê=^Çî~åÅÉÇ=q~Ä
jçÇáÑó=íÜÉ=^Çî~åÅÉÇ=í~Ä=ëÉííáåÖë=çåäó=áÑ=óçì=ï~åí=íç=ÅêÉ~íÉ=~å=
^Çãáåáëíê~íáîÉ=áåëí~ää~íáçåK=qÜÉ=~Çãáåáëíê~íáîÉ=áåëí~ää~íáçå=ÇçÉë=åçí=
~Åíì~ääó=áåëí~ää=íÜÉ=éêçÇìÅíX=áåëíÉ~ÇI=áí=éä~ÅÉë=~å=áã~ÖÉ=çÑ=fkcl`çååÉÅí=
çå=~=åÉíïçêâ=äçÅ~íáçå=Ñçê=ä~íÉê=áåëí~ää~íáçå=íç=ãìäíáéäÉ=ïçêâëí~íáçåëK=qÜáë=
åÉíïçêâ=äçÅ~íáçå=Å~å=ÄÉ=ìëÉÇ=Äó=ÇÉéäçóãÉåí=íççäë=íç=~ÅÅÉëë=~åÇ=ÅêÉ~íÉ=
é~Åâ~ÖÉë=íÜ~í=~êÉ=ÇÉéäçóÉÇ=íç=ïçêâëí~íáçåëI=~åÇ=ÉåÇ=ìëÉêë=Å~å=
éÉêÑçêã=ïçêâëí~íáçå=áåëí~ää~íáçåë=Äó=êìååáåÖ=ëÉíìéKÉñÉ=Ñêçã=íÜáë=
äçÅ~íáçåK

cçääçïáåÖ=~êÉ=ÇÉëÅêáéíáçåë=çÑ=íÜÉ=çéíáçåë=~î~áä~ÄäÉ=Ñêçã=íÜÉ=^Çî~åÅÉÇ=
í~ÄW

kçíÉW=cçê=ãçêÉ=áåÑçêã~íáçå=~Äçìí=áåëí~ää~íáçå=çéíáçåë=~åÇ=
Åìëíçãáò~íáçåëI=ëÉÉ=íÜÉ=fkcl`çååÉÅí=båíÉêéêáëÉ=bÇáíáçå=mêçÇìÅí=dìáÇÉK

pí~êíáåÖ=~åÇ=píçééáåÖ=íÜÉ=d~íÉï~ó=pÉêîáÅÉ
fkcl`çååÉÅí=̂ áêäáåÉë=d~íÉï~ó=áë=~=táåÇçïë=ëÉêîáÅÉ=íÜ~í=óçì=ãìëí=ëí~êí=
ã~åì~ääó=íÜÉ=Ñáêëí=íáãÉ=óçì=ìëÉ=áíK=låÅÉ=óçì=ëí~êí=íÜÉ=ëÉêîáÅÉI=áí=êÉëí~êíë=
~ìíçã~íáÅ~ääó=É~ÅÜ=íáãÉ=óçì=êÉëí~êí=íÜÉ=ëÉêîÉê=çå=ïÜáÅÜ=áí=áë=áåëí~ääÉÇK

kçíÉW=vçì=ãìëí=ëíçé=íÜÉ=ëÉêîáÅÉ=áÑ=óçì=áåëí~ää=~=åÉïÉê=îÉêëáçå=çÑ=
fkcl`çååÉÅí=`çååÉÅíáîáíó=pÉêîáÅÉëK

vçì=Å~å=ëí~êí=çê=ëíçé=íÜÉ=Ö~íÉï~ó=ìëáåÖ=ÉáíÜÉê=d~íÉï~ó=^Çãáåáëíê~íçê=
çê=táåÇçïë=`çåíêçä=m~åÉäK=qÜÉ=ëÉêîáÅÉ=å~ãÉ=áë=^qjfÅëd~íÉK

léíáçå aÉëÅêáéíáçå

Install to this PC Installs INFOConnect Airlines Gateway to your 
computer.

Create an 
administrative install 
image on a server

When you create an administrative installation 
image, an image of the product is copied to a 
network location for later installation to 
multiple workstations. This network location 
can be used by deployment tools to access and 
create packages that are deployed to 
workstations. Also, end users can perform 
installations by running setup.exe from this 
location.

Create a log file for this 
installation

Specifies whether or not a log file is created. 
The installation log file, which provides details 
about the installation, is saved in the user’s 
temp directory (%tmp%) with a generated 
name that begins with atm. To open this folder, 
launch the Start menu Run command and enter 
%tmp%.
S



qç=ëí~êí=çê=ëíçé=íÜÉ=d~íÉï~ó=ëÉêîáÅÉ=ìëáåÖ=d~íÉï~ó=^Çãáåáëíê~íçê

1. Start the Gateway Administrator.

For more information, see “Starting the Gateway Administrator.”

2. In the path tree, click the name of the computer on which the Gateway is 
installed.

3. Do one of the following: 

qç=îÉêáÑó=óçìê=~ÅíáçåI=pí~íÉ=Çáëéä~óë=píçé=ïÜÉå=óçì=êÉèìÉëí=~=ã~åì~ä=
ëíçé=~åÇ=íÜÉ=ëÉêîáÅÉ=áë=áå=íÜÉ=éêçÅÉëë=çÑ=ëíçééáåÖI=píçééÉÇ=ïÜÉå=óçì=
Ü~îÉ=ëìÅÅÉëëÑìääó=ëíçééÉÇ=íÜÉ=Ö~íÉï~ó=~åÇ=oìååáåÖ=ïÜÉå=óçì=Ü~îÉ=
ëìÅÅÉëëÑìääó=ëí~êíÉÇ=íÜÉ=Ö~íÉï~óK

pí~êíáåÖ=íÜÉ=d~íÉï~ó=^Çãáåáëíê~íçê
d~íÉï~ó=^Çãáåáëíê~íçê=áë=~å=~ééäáÅ~íáçå=íÜ~í=óçì=Å~å=ìëÉ=íç=ÅêÉ~íÉI=
ãçÇáÑóI=~åÇ=ÇÉäÉíÉ=íÜÉ=é~íÜë=ìëÉÇ=íç=Éëí~ÄäáëÜ=ÅçååÉÅíáçåë=ÄÉíïÉÉå=íÜÉ=
åÉíïçêâÉÇ=m`ë=~åÇ=íÜÉ=ÜçëíK=qÜÉ=äÉÑí=é~åÉ=çÑ=íÜÉ=d~íÉï~ó=
^Çãáåáëíê~íçê=~ééäáÅ~íáçå=ïáåÇçï=Çáëéä~óë=~=íêÉÉ=îáÉï=çÑ=íÜÉ=ÅäáÉåí=~åÇ=
Üçëí=é~íÜë=íÜ~í=~êÉ=~î~áä~ÄäÉK=^ë=óçì=ÅêÉ~íÉ=åÉï=Üçëí=é~íÜëI=íÜÉëÉ=
é~íÜë=~ééÉ~ê=çå=íÜÉ=é~íÜ=íêÉÉK

qç=ëí~êí=d~íÉï~ó=^Çãáåáëíê~íçê

1. Log in to the server where INFOConnect Airlines Gateway is installed.

You must run Gateway Administrator directly from the server; you 
cannot run it from a networked PC connected to the server.

2. From the Start menu, open Gateway Administrator from the 
Attachmate INFOConnect Airlines Gateway Programs group.

3. The first time you start Gateway Administrator, you are prompted to 
type and confirm a password for this application. Subsequently, you must 
type this password any time you run the application.

The password for Gateway Administrator is the same as the 
administrator password for INFOConnect Manager. If you change the 
administrator password using INFOConnect Manager, the same change 
is made in Gateway Administrator, and vice versa.

Once you type a valid password, Gateway Administrator starts.

`äáÅâ qç=Çç=íÜáë

Start Start the Gateway.

Stop Stop the Gateway.
T
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j~å~ÖáåÖ=eçëí=`çååÉÅíáçåë

To establish connections between networked PCs and a host, INFOConnect 
Airlines Gateway must receive connection requests from the networked PCs 
and then establish a connection with the host. It does this using paths.
A path is a named set of configuration data about the connection. The 
Airlines Gateway uses two types of paths:
• Host paths, which connect the Gateway to the host using one of the five 

Gateway transports: SABREGW (OFEP support), SABRE2 (NOFEP 
support), MATIPGW, UDPFRAD and ATSTCPGW. Host paths can be 
created using the Configuration Translation wizard or the Add Host 
Paths wizard.

• Listening paths, which the client PC uses to connect to the Gateway 
using the AIRGATE transport or another Gateway-compatible 
transport.

These paths are shown in the figure below:

A configuration translation maps a host path to a listening path. 
Configuration translations are created using the Configuration Translation 
wizard.
V



fkcl`çååÉÅí=^áêäáåÉë=d~íÉï~ó=mêçÇìÅí=dìáÇÉ
eçëí=m~íÜë
There are two types of host paths: single connection paths and pooled 
connection paths. You can have both a single connection host path and a 
pooled host path going to the same host. For example, if you had one printer 
and 50 terminals, you might configure the printer session to use a single 
connection path and the terminals to use a pooled connection path. 

páåÖäÉ=`çååÉÅíáçå=eçëí=m~íÜë
A single connection path contains configuration data for only one 
connection to a host. If you create single connection paths, you can create 
one for each networked PC that connects to INFOConnect Airlines 
Gateway. For example, if 50 networked PCs connect to INFOConnect 
Airlines Gateway, you must create 50 single connection paths. 
Using single connection paths does provide greater security because you can 
assign a particular path to each networked PC.

mççäÉÇ=`çååÉÅíáçå=eçëí=m~íÜë
A pooled connection path contains configuration data for multiple 
connections to a host. If you create pooled connection paths, you need to 
create only one for all the networked PCs that connect to INFOConnect 
Airlines Gateway. For example, if 50 networked PCs connect to 
INFOConnect Airlines Gateway, all 50 can connect to the host using the 
same pooled connection path.
You should use good judgment for your situation when creating pooled 
connection paths. With multiple users accessing the same path, pooled 
connection host paths do not offer the same security level provided by single 
connection host paths.

aÉíÉêãáåáåÖ=íÜÉ=kìãÄÉê=çÑ=m`ë=rëáåÖ=~=mççäÉÇ=`çååÉÅíáçå=m~íÜ
The number of networked PCs that can use a pooled connection path varies, 
depending on how many host addresses you assign to that path. For 
example, you could create a pooled connection path called MATIP_1 and 
assign 20 host addresses to that path. Each time a networked PC connects 
to INFOConnect Airlines Gateway and uses that path, one of the host 
addresses is assigned to that PC. Once 20 networked PCs have accessed the 
path, all the available host addresses will be in use, and no other networked 
PCs will be able to access the host using that path. If the pooled connection 
path contains fewer host addresses than the number of networked PCs that 
will be connecting to INFOConnect Airlines Gateway, you must create 
multiple pooled connection paths.
Some things to consider when you are determining the number of PCs that 
will use a pooled connection path:
• One pooled connection path with many host addresses

– Advantage: It’s easy to remember the name.

– Disadvantage: A longer access time during connection of the client 
slows down the connection process.

• Multiple pooled connection paths with fewer host addresses
NM



– Advantage: You can group pooled connections by name, such as 
Accounting, Sales, or Second Floor.

– Disadvantage: There are more paths to maintain.

`êÉ~íáåÖ=~=eçëí=m~íÜ
When you are prompted for a value that must be unique to each host 
connection, such as the terminal address (TA), you can also specify a 
number in the Multiplier text box. The multiplier creates the specified 
number of automatically incremented values. For example, to create a 
pooled connection path with ten TAs, you would specify the beginning TA 
and then type 10 in the Multiplier text box.

qç=ÅêÉ~íÉ=~=Üçëí=é~íÜ

1. Start Gateway Administrator.

2. From the Path menu, click Add host path.

3. (Optional) Create a host path when creating a configuration translation.

4. Respond to the prompts in the Host Path wizard.

The information for which you are prompted varies depending on which 
transport you are using.

iáëíÉåáåÖ=m~íÜë
When Gateway Administrator is run for the first time, the INFOConnect 
path used to receive incoming client connections is automatically created. 
(This path is named ATM_TCP_1 by default.) When the Gateway service is 
running, by default, five instances of this listening path are active, listening 
for incoming connections. Depending upon the number of anticipated client 
connections, it may be necessary to increase the default number of listening 
paths by changing the Number listening on the Translations page.
Configuration translations are the rules for mapping listening paths to host 
paths. When you create a configuration translation, you specify which host 
path to use to establish a connection with the host. If a host path does not 
already exist, the configuration translation wizard prompts you to create 
one. For more information, refer to the next section, “Creating a 
Configuration Translation.”

`êÉ~íáåÖ=~=`çåÑáÖìê~íáçå=qê~åëä~íáçå
Configuration translations are the rules for translating client connection 
information to host connection information. INFOConnect Airlines 
Gateway includes a Translation wizard to assist you in creating 
configuration translations. Using the Translation wizard, you can specify 
which host path to use based on the configuration of your networked PCs.
You can add more configuration translations as you need them, which allows 
you to create specific rules for connecting clients to host connections as your 
situation requires.

qç=ÅêÉ~íÉ=~=ÅçåÑáÖìê~íáçå=íê~åëä~íáçå

1. Open Gateway Administrator.
NN
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2. From the tree view, select Configure.

3. From the Translation tab, click Add.

4. Respond to the prompts in the Translation wizard. 

The information for which you are prompted varies, depending on which 
transport you are using and whether you want to select an existing host 
path or create a new one.

p~ÄêÉ=klcbm=`çããìåáÅ~íáçåë=mêçíçÅçä=pìééçêí
Use the following instructions to connect the gateway with the Sabre No 
Open Front End Processor (NOFEP) system. Customers are required to 
license CCSAPI from Sabre before they connect via INFOConnect. 
Install CCSAPI (the Sabre API) before you install INFOConnect Airlines 
Gateway version 3.0. For information on the API installation, refer to the 
Sabre documentation. 

qç=îÉêáÑó=~ÅÅÉëë=íç=p~ÄêÉ

Test the following connections:

– Telnet to access.sabre.com port 30031 (TA access)

– Telnet to access.sabre.com port 30032 (Agency Pooled TA access)

– Telnet to access.sabre.com port 30051 (Printer access)

– Telnet to hsspconfig.sabre.com 389 (LDAP services for NOFEP 
access)

qç=ÅçåÑáÖìêÉ=Åë~éáKÅÑÖ

CCSAPI takes its configuration settings from the Csapi.cfg file, which must 
be placed in the Windows directory.
1. From the Windows directory, open Csapi.cfg in Notepad.

2. Locate the Route names section.

3. In the FIXEDTERMINALHSSP2 entry (or your own route, if you have created 
one), replace PUT_YOUR_PROVIDED_VALUE_HERE with (one of) the 
address(es) provided to you by Sabre (a six-digit hex number).
NO



4. Locate the {hssp2terminalfixed section.

5. Modify SKIPLEADINGCHARS to equal 3.

6. Modify EBCDIC2ASCII to equal “NO”.

7. Save and close the file.

qç=ÇÉÑáåÉ=~=p~ÄêÉ=klcbm=Üçëí=é~íÜ

1. In Attachmate Gateway Administrator, select Configure in the tree view 
in the left pane.

2. In the right pane, click Add.

3. Proceed through the normal steps to configure a Translation. For more 
information, refer to the information in this product guide and Gateway 
Administrator Help.

4. When asked for the transport to use, select SABRE2, and then click 
Next.

5. When asked for the route name (from Csapi.cfg) enter 
FIXEDTERMINALHSSP2 or, if you have created one, the name of your 
own route.

6. Complete the configuration of the Translation.

qê~ÅáåÖ=fkcl`çååÉÅí=m~íÜë
In some situations, communication problems might be caused by the 
transport rather than the gateway. To determine if this is the case, you 
must trace the INFOConnect path being used.

qç=íê~ÅÉ=fkcl`çååÉÅí=é~íÜë

1. Make sure all users are logged off, then stop the Gateway Service.

For more information, refer to “Starting and Stopping the Gateway 
Service.”

2. From the Start menu, select INFOConnect Manager from the Tools 
menu of the Attachmate INFOConnect Airlines Gateway program 
group.

3. From the Administer menu, click Administrator login.

4. Type your password and click OK.

This is the same password that you use for Gateway Administrator.
NP
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5. From the Administrator menu, click Trace. 

The Trace Log Options dialog box appears with the following options:

Enable Trace Log: Select this option to enable the trace log facility. 

Write to Log File: Select this option to store trace information in a file 
called \datadir\Trace.log, where datadir is the name of the 
INFOConnect data directory (this is the Windows directory by default). 

Add Time Stamps: Select this option to add a time stamp to each entry 
that is logged. 

Show Xmt/Rcv Buffer Contents: Select this option to show the contents 
of data buffers that are being transmitted and received. This will 
generate a listing of both the hexadecimal value of each byte plus the 
character. The format will be 16 bytes per line.

Trace Library API Calls: Select this option to show the returned results 
from routines that INFOConnect called in a library. The APIs that are 
logged are IcLibOpenChannel, IcLibOpenSession, IcLibCloseChannel, 
IcLibCloseSession, IcLibIdentifySession, IcLibInstall and 
IcLibTerminate. This option also causes the library load and free calls to 
be logged.

Trace IC_OK Results: This option works in conjunction with the Trace 
Library API calls. If not selected only API calls that return a result other 
than IC_OK will be logged. Enable Trace Log, Write to Log File, Add 
Time Stamps, Show Xmt.rcv Buffer Contents, Trace Library API Calls, 
and Trace IC_OK Results.

Custom Trace File Location: Specify the path where you want log files to 
be saved.

Maximum File Size: Specify the maximum file size before the trace file 
splits into a new file.

Number of File Cycles: Specify the number of files the trace log will split 
into (for example trace.log.1, trace.log.2), when the maximum file size is 
reached. When all of these files have reached their maximum file size, 
the process repeats itself and the first file is overwritten with additional 
trace data.   

6. Click OK. 

7. From the task bar at the bottom of the screen, click the INFOConnect 
Trace Log icon.

The INFOConnect Trace Log window appears.

8. From the Options menu of the INFOConnect Trace Log window, select 
Session Trace.

9. For the All paths, Paths with trace, and Templates with trace options, 
select Libraries, and then click OK.

10. From the Administrator menu, click Exit INFOConnect.

11. Start the Gateway.

12. Test opening a session with the host.
NQ



INFOConnect Manager traces the communication at the transport level 
and records the information in the Trace.log file in the install folder on 
the server where Gateway Monitor is installed (by default, \Program 
Files\Attachmate\Infocnee\Gateway).

kçíÉW=qÜÉ=qê~ÅÉKäçÖ=ÑáäÉ=Å~å=ÄÉÅçãÉ=îÉêó=ä~êÖÉI=ëç=ÄÉ=ëìêÉ=íç=ÇÉäÉíÉ=
áí=~ÑíÉê=óçì=ÅçãéäÉíÉ=É~ÅÜ=íê~ÅÉK

bÇáíáåÖ=~=m~íÜ

You can edit existing host paths in Gateway Administrator.

kçíÉW=fÑ=óçì=ãçÇáÑó=~=é~íÜ=íÜ~í=áë=ÅìêêÉåíäó=áå=ìëÉI=åç=Çáëêìéíáçå=çÅÅìêë=
áå=ÅçããìåáÅ~íáçåI=Äìí=íÜÉ=ÅÜ~åÖÉë=ïáää=åçí=í~âÉ=ÉÑÑÉÅí=ìåíáä=íÜÉ=åÉñí=íáãÉ=
íÜÉ=é~íÜ=áë=ìëÉÇK=fí=áë=êÉÅçããÉåÇÉÇ=íÜ~í=óçì=ãçÇáÑó=é~íÜë=çåäó=ïÜÉå=
íÜÉó=~êÉ=åçí=áå=ìëÉK

qç=ÉÇáí=~=é~íÜ

1. In Gateway Administrator, from the path tree, select the path that you 
want to edit.

2. In the right pane of the Gateway Administrator application window, 
make your changes to the path.

The items that appear here vary, depending on which type of path you 
clicked. If the application window displays a Configure Path or Configure 
Channel button, be sure to click these buttons to configure the path.

To change a pooled connection path into a single connection path, delete 
all of the pooled ASCUs, GTIDs, or LNIATAs in the list box, and then 
add the new single connection path. To change a single connection path 
into a pooled connection path, type the ASCU, GTID, or LNIATA in the 
appropriate text box, and then click Add.

3. From the Path menu, choose Save.

aÉäÉíáåÖ=~=m~íÜ

You can delete host paths in Gateway Administrator.

qç=ÇÉäÉíÉ=~=é~íÜ

1. In Gateway Administrator, from the path tree, select the path that you 
want to delete.

2. From the Path menu, choose Delete.

-or-

Right-click the path that you want to delete and then click Delete Path.

If you delete a path that is currently in use, no disruption occurs in 
communication, but the networked PC will not be able to access the host 
the next time using that path. It is recommended that you delete paths 
only when they are not in use.
NR
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jçåáíçêáåÖ=`çããìåáÅ~íáçå

Gateway Monitor displays information about communication between the 
networked PCs, INFOConnect Airlines Gateway, and the host. Using the 
Gateway Monitor, you can check to see which paths are active and which 
aren. Additionally, you can determine how many users are connected and 
who is connected to the gateway.

Using Gateway Monitor, you can close connections between the networked 
PCs and the host, and you can trace communication between a networked 
PC, the gateway, and the host to determine whether communication 
problems are occurring at the gateway. 

When you trace a session, you record all raw protocol data in a file called 
AtmGpSrv.log. This log file is located in the install folder on the server 
where Gateway Monitor is installed (by default, ..\Program 
Files\Attachmate\Infocnee\Gateway). Each time you trace a session, the 
newly recorded data is appended to this file.

The information in this log file can indicate whether or not communication 
problems are being caused by the Airlines Gateway. If the data provided by 
the trace does not indicate that the gateway is the source of the problem, 
you might need to trace the path using the INFOConnect Manager. This 
provides trace information at the transport level rather than at the gateway 
level. For more information, refer to Tracing INFOConnect Paths.

If you are not familiar with raw protocol data, you can send the log file to 
Attachmate Customer Support for review.

pí~êíáåÖ=d~íÉï~ó=jçåáíçê
To start Gateway Monitor, click Monitor in the Gateway Administrator 
path tree or use the following procedure to launch Gateway Monitor in its 
own window.

qç=ëí~êí=d~íÉï~ó=jçåáíçê

1. At the server where INFOConnect Airlines Gateway is installed, log on 
as an administrator.

You must be logged onto the server as an administrator or as a user with 
administrator privileges to view any data using this utility. If you are not 
logged on as an administrator, Access Denied appears in the Server 
Status area of the application window, and the rest of the application 
window is blank.

2. From the Start menu, select Gateway Monitor from the Attachmate 
INFOConnect Airlines Gateway programs group.

a~í~=mêçîáÇÉÇ=Äó=íÜÉ=d~íÉï~ó=jçåáíçê

The Gateway Monitor application window displays the following data:

• The status of the gateway (itrunning indicates Active status; itnot 
indicates Inactive status; Access Denied indictes that you are not logged 
onto the server as an administrator).
NT
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• The number of sessions currently available to receive connection 
requests from the networked PCs (the default value is 5).

• The number of currently active sessions (that is, the number of 
networked PCs that are currently connected to the gateway).

• The following information for the currently active sessions:

Gateway Monitor can monitor only the sessions managed by the gateway 
on the same server where this utility is installed.

`äçëáåÖ=~=pÉëëáçå
You can close one or more active sessions from within Gateway Monitor.

qç=ÅäçëÉ=~=ëÉëëáçå

1. From the Active tab, select the ID of the session that you want to close.

`çäìãå aÉëÅêáéíáçå

ID The internal number that the gateway uses to identify 
the session with the host

Status The status of the session (only Open is currently 
supported)

User The IP address of the networked PC

Host session The name of the path and the station name or terminal 
ID associated with it

From client The number of buffers sent from the networked PC to 
the gateway

To host The number of buffers sent from the gateway to the 
host

From host The number of buffers sent from the host to the 
gateway

To client The number of buffers sent from the gateway to the 
networked PC

Trace The tracing status of the session (On if tracing is 
currently occurring, Off if it is not)

Client 
session

The listening path that is in use by the particular 
session (only ATM_TCP_1 is currently supported)

Gw protocol The high-level protocol used to communicate between 
the client and Gateway (only AIRGATE is currently 
supported)

Nw protocol The low-level transport protocol used between client 
and gateway (only TCP is currently supported)
NU



You can select multiple sessions to close them simultaneously.

2. Click Close.

A message indicating that the connection is being closed is sent to the 
networked PCs, the sessions are closed, and the names of the sessions 
disappear from the Active Sessions list box.

qê~ÅáåÖ=~=pÉëëáçå
You can trace one or more active sessions from within Gateway Monitor. 
See also “Tracing INFOConnect Paths” on page 15.

qç=íê~ÅÉ=~=ëÉëëáçå

1. Do one of the following:

2. From the Active tab, select the ID of the session that you want to trace. 

You can select multiple sessions to trace them simultaneously.

If you select more than one session listed on the Active tab, all of the 
sessions must have the same Trace status. For example, all of the 
selected sessions must have a Trace status of Off (to begin tracing all of 
them) or On (to stop tracing all of them).

3. Click the Trace button.

All raw protocol data and any data typed at the networked PC are 
recorded in a file called AtmGpSrv.log. This log file is located in the 
install folder on the server where Gateway Monitor is installed by 
default, ..\Program Files\Attachmate\Infocne\ Gateway. Each time you 
trace a session, the newly recorded data is appended to this file, so be 
sure to delete the file when you are finished with it to ensure that it does 
not become too large.

qç=ÄÉÖáå=íê~ÅáåÖ aç=íÜáë

All sessions as soon as 
each connection request 
is received by the gateway

On the Listening tab of the Monitor 
screen, select an ID and click Trace. As 
client sessions become active they will be 
traced immediately.

One or more currently 
active sessions

Go to step 2.
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^ééÉåÇáñ=^W=rëáåÖ=`åÑbÇáí

Some user applications may require a file with the extension .cnf to hold 
translation tables and other communications data. A .cnf file is in binary 
format and can only be edited using the CnfEdit program. Several different 
options can be modified using CnfEdit. Some are not used with current 
products, but are retained for compatibility with older gateway products.

kçíÉëW=
√=q~âÉ=ÖêÉ~í=Å~êÉ=ïÜÉå=ÅÜ~åÖáåÖ=KÅåÑ=î~äìÉëK=aç=åçí=ÅÜ~åÖÉ=~=î~äìÉ=
ìåäÉëë=óçì=~êÉ=ëìêÉ=íÜ~í=íÜÉ=åÉï=î~äìÉ=áë=î~äáÇK

√==tÜÉå=óçì=ìéÇ~íÉ=~=KÅåÑ=ÑáäÉI=íÜÉ=ÅÜ~åÖÉë=Çç=åçí=í~âÉ=ÉÑÑÉÅí=ìåíáä=íÜÉ=
éêçÇìÅí=ìëáåÖ=íÜÉ=ÑáäÉ=áë=êÉëí~êíÉÇK

qç=ìëÉ=`åÑbÇáí

1. From the command line, navigate to Infocnee/Cnf and locate the .cnf file 
with which you want to work.

2. From the command line, type: 

path/CnfEdit

where path is the path to CnfEdit.

3. Press ENTER. 

The File Selection screen is displayed.

4. Type the name of the .cnf file you want to edit, then press ENTER.

The Configuration Categories menu is displayed. The column on the left 
provides a list of six categories. When you move the cursor over a 
category name, the column on the right provides a list of all the options 
in that category.

5. Move the cursor over the category containing the options you want to 
edit, and then press Enter. A new screen for editing the options in that 
category is displayed.
ON
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`åÑbÇáí=`~íÉÖçêáÉë=~åÇ=léíáçåë

`~íÉÖçêó léíáçåLaÉëÅêáéíáçå

IA Level Data Entry Airline Code
The airline code will be set correctly when you 
receive the .cnf file. Do not change this code unless 
you are sure that the current code is not correct.

Interchange Address
Retained for compatibility with other gateway 
software. Do not set any values for this parameter.

Host Type
The host type will be set correctly when you receive 
the .cnf file. Do not change the host type.

Code Host

00
01
02
03
04
05
06
07
08
09
0A
0B
0C
0D
0E
0F
10
11
12
14
15

16

Any host type not listed here
SABRE
SABRE (FOS)
British Airways (BABS)
Continental
CPARS
JALCOM
KLM (CORDA)
QANTAS (QANTAM)
Worldspan (PARS)
Apollo
Egypt Air
El Al (Israel Airlines)
Thai Airways
Canadian Airlines
Garuda
Abacus
Amadeus
Apollo 2915
Shares
System One/Amadeus (Unison ALC 
    specification)
Turkish

SITA Message TA
Retained for compatibility with other gateway 
software. Do not set any values for this parameter.

Response Interchange Address
Retained for compatibility with other gateway 
software. Do not set any values for this parameter.

TA Tables Retained for compatibility with other gateway 
software. Do not set any values for this parameter.
OO



Screen Translate 
Tables

Because screen translation is a two-way process, 
two screen translate tables are supplied with the 
correct settings for your host. One is used to 
translate data going to the host; the other is used to 
translate data coming from the host. Do not change 
the setting unless you are certain that you are 
entering correct values.

Any value may be entered into the tables and very 
little validation is carried out; therefore, the user 
must ensure that the data input is correct.

Communications This screen displays all of the items in the 
configuration file that are associated with 
communication between the gateway and the host. 
Care should be taken when changing these values 
as it is possible to select combinations of values that 
will prevent data transmission.

The Help screen at the bottom right of the screen 
displays further information about the item 
situated at the cursor, and also indicates the type of 
data expected as input.

Printer Translate Because printer translation is a one-way process 
from the host to the printer, only one table is 
required. Do not change the setting unless you are 
certain that you are entering correct values.

Most printer character translations will be the 
same as the display translation. However, some 
characters will be different. No more than 15 
differences are allowed between the display and 
printer translation tables. If there are more than 15 
differences, a warning message is displayed. At this 
point, it is possible to edit either table until only 15 
differences between them are outstanding. The file 
cannot be saved if there are more than 15 
differences.

Printer Escape These options are not used.
OP
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^ééÉåÇáñ=_W=bêêçê=jÉëë~ÖÉë

The following table lists Gateway Administrator error messages and 
suggested responses. For information about the error messages associated 
with each transport, refer to the online Help.

bêêçê=jÉëë~ÖÉ aÉëÅêáéíáçåLoÉÅçããÉåÇ~íáçå

A host channel with that 
name already exists.

Choose a different name for the new 
SABRE Host Channel and try again.

A Host Connection with that 
name already exists.

You cannot add a host connection that has 
the same name as an existing host 
connection. Choose a new name (up to 15 
characters) and try again.

A path with this name 
already exists. Do you want 
to overwrite it with the one 
you just created?

You cannot add a path that has the same 
name as an existing path. Choose a new 
name (up to 15 characters) and try again.

A Pool with that name 
already exists.

Choose a new name for the address pool 
and try again.

A GTID pool must be 
selected. 

Select a GTID Pool from the list.

A specific GTID must be 
selected.

Select a GTID from the list.

An error occurred while 
trying to add a new Host 
Connection.

A severe error occurred while trying to 
create a new MATIP Host connection. 
Contact Attachmate.

An error occurred while 
trying to add a new Pool.

A severe error occurred while trying to 
create a new address pool. Contact 
Attachmate.

An error occurred while 
trying to add to the Address 
Pool.

A severe error occurred while trying to 
add an address to a Pool. Contact 
Attachmate.

An error occurred while 
trying to delete from the 
Address Pool.

A severe error occurred while trying to 
delete an address from a Pool. Contact 
Attachmate.

An error occurred while 
trying to delete the current 
Host Connection.

A severe error occurred while trying to 
delete a MATIP Host connection. Contact 
Attachmate.

Changes are pending. Please 
Save or Cancel the current 
updates before continuing.

Save or cancel pending changes before 
continuing.
OR
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Changes have been made. 
Would you like to save 
them?

You tried to switch focus from one path to 
another without saving your changes. 
Click OK to save the changes or Cancel to 
cancel the changes.

Host Connections names 
must be between 1 and 15 
alphanumeric characters 
long. 

Choose a new name and try again.

Invalid SABRE address 
value.

SABRE LNIATA address bytes must be a 
hexadecimal number between 0x00 and 
0xFF, inclusive. Choose a new value and 
try again.

MATIP address bytes must 
be a hexadecimal number in 
the range 0x00-0xFF, 
inclusive. 

Choose a new value and try again.

Memory error. Insufficient memory is available to run 
Gateway Administrator. Close any 
unneeded applications and try again.

Old password does not 
verify, try again?

When changing the password, you 
specified an old password that does not 
match the existing password. Retype the 
old password and try again.

Password does not verify, try 
again?

The password you typed to access Gateway 
Administrator is not valid. Retype the 
password and try again.

Please specify a DNS name 
or IP address for the host.

Type an IP address or Domain Name for 
the SABRE Host.

Please specify a new host 
channel name. 

Type a name for the new SABRE host 
channel.

Please specify a Pool name. Type a name for the address pool.

Request to delete item in use 
rejected. You must first 
delete all references to the 
item.

You tried to delete an item that is in use. 
For example, you might have tried to 
delete an INT1 environment that was in 
use by an INT1 path. You must remove all 
references to the item that you want to 
delete before you can delete it.

Sorry this Install Type is not 
supported by this version of 
Gateway Administrator.

You tried to use Gateway Administrator 
with a version of the INFOConnect 
database that it does not support. Make 
sure that the Windows registry 
(HKEY_LOCAL_MACHINE\SOFTWAR
E\Attachmate\AlcGW\-
WorkstationUser\Preferences\DirIC32CF
G) specifies a valid INFOConnect database 
and try again.
OS



Spaces are not allowed in the 
fieldname.

You typed a space in a field (such as Class 
Name or Channel Name) that does not 
allow spaces. Use underlines or hyphens 
instead of spaces and try again.

The two copies of your new 
password are not the same, 
try again?

The password you typed in the Confirm 
New Password text box does not match the 
password you typed in the New Password 
text box. Retype either the New Password 
or Confirm New Password passwords and 
try again.

There are no entries to 
delete.

There are no address pools to delete.

This Host Connection is still 
in use. Continue? 

The Host connection is still in use by at 
least one Host Path.

You can not have a blank 
password.

You must specify a password in order to 
start Gateway Administrator. Type a 
password in the New Password and 
Confirm New Password text boxes and try 
again.

You do not have a valid 
INFOConnect installed, or 
it’s been corrupted.

Gateway Administrator cannot open the 
INFOConnect database. The database 
might not be the appropriate one, or the 
file might have become corrupted or 
damaged. Make sure that the Windows 
registry 
(HKEY_LOCAL_MACHINE\SOFTWAR
E\Attachmate\AlcGW\-
WorkstationUser\Preferences\DirIC32CF
G) specifies a valid INFOConnect database 
and try again. If necessary, reinstall 
INFOConnect Airlines Gateway.

You do not have 
INFOConnect installed, or 
it’s not accessible at this 
time.

Gateway Administrator could not find the 
INFOConnect database. Make sure that 
the database resides in the Windows folder 
on the server where INFOConnect 
Airlines Gateway was installed and try 
again. If necessary, reinstall INFOConnect 
Airlines Gateway.

You must have a fieldname 
to continue.

Type a value for the specified field and try 
again.
OT
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Gateway Administrator

An application that you can use to add, modify, and delete paths or path-
related components, and to start, stop, or monitor the gateway service.

host

A mainframe, mini-computer, or information hub with which the 
networked PCs communicate.

host path

A path that is configured to establish a connection between 
INFOConnect Airlines Gateway and a host.

INFOConnect Connectivity Services

A package of INFOConnect products that includes INFOConnect 
Manager and other INFOConnect software.

INFOConnect database

A file (IC32.cgf) usually located in the Gateway folder that contains 
information about all the INFOConnect packages that have been 
installed, as well as all the path templates, library channels, and paths 
that have been created.

INFOConnect Manager

The application that runs in the background each time you run an 
INFOConnect product and that controls interaction between accessories 
and transports.

You can also use this application to create, modify, and delete paths; set 
administrator and user-level security; control user access to 
configuration; and set user preferences. INFOConnect Manager also lets 
you switch between sessions, clear sessions, and view session status.

listening path

A path that is configured to receive connection requests and establish 
communication between the networked PCs and INFOConnect Airlines 
Gateway. This path is created automatically when the Gateway 
Administrator is first run.

path

A named set of configuration data required to establish communication 
between the PC and a host.

path tree

The tree that appears in the left pane of the Gateway Administrator 
application window. At the top of the path tree is an icon for the server 
where the INFOConnect database is located (such as C:\WINDOWS). 
As you create paths, those paths also appear in the tree.

pooled connection path

A path that contains configuration data for multiple connections to a 
host.
OV
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single connection path

A path that contains configuration data for a single connection to a host.

transport

The communication software that enables a PC to communicate with a 
host via a specific type of network. For example, the INFOConnect TCP/
IP Transport enables communication via a TCP/IP network.
PM
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Access Denied message, 17
administrative installation, Advanced tab, 6
administrator password, 7
AIRGATE, 17
Airgate transport, 2
ATM_TCP_1, 11
AtmGpSrv.log, 17, 19
ATMIcsGate, 6
ATSTCPGW, 9
Attachmate Installer Program, 5

`
client connections, 11
closing a session, 19
components, 2
configuration translation, 9, 12
Configuration Translation wizard, 9
configuring

channel, 15
path, 15

connections, number of, 1
creating a host path, 11

a
data provided by the Gateway Monitor, 17
deleting a path, 15
diagram, 9

b
editing a path, 15

d
Gateway

Administrator, 7
transports, 9

Gateway Monitor
overview, 17
starting, 17

Gw Protocol, 17

e
help, 4
Host Path wizard, 11
host paths, 10
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incoming connections, 11
INFOConnect Manager, 13
installation, 5
Installer Advanced tab, 6
installers, 1
IPv6, 1

j
Manager 32-bit, 13
managing host connections, 9
MATIPGW, 9
monitoring

gateway communication, 17
transport communication, 13

multiple pooled connection paths, 10
multiplier, 11

k
new features, 1
Number Listening, 11
Nw Protocol, 17

m
path

deleting, 15
diagram, 9
editing, 15
host, 10
listening, 11
pooled connection, 10
single connection, 10

Path wizard, 11
pooled connection paths, 10
product guide, 4

o
raw protocol data, 17
reference, Data Provided by the Server Monitor, 17
requirements, 3
restarting Gateway, 6

p
Sabre NOFEP support, 1
SABREGW, 9
service name, 6
session

closing, 19
tracing, 19

setup.exe, 5
single connection paths, 10
starting
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Gateway Administrator, 7
Gateway Monitor, 17
Gateway Service, 6

stopping the Gateway Service, 6
system requirements, 3

q
TCP, 3, 17
terminal address (TA), 11
TRACE.LOG, 13
tracing

a session, 19
INFOConnect Paths, 13

Translation wizard, 12
transports, 9

s
VPA numbers, 5

t
Windows Control Panel, 6
Windows Vista certification, 1
WIX, 1
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